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Valkyrie2889
User Manual
This is the User Manual for Valkyrie2889. Valkyrie2889 is a PC application
that enables you to perform advanced network tests according to the RFC
2889 specification using one or more of the Xena test equipment chassis.
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USER MANUAL

Contents
INSTALLATION.................................................................................................................................................... 3
GENERAL INFORMATION ................................................................................................................................... 3
Capabilities .................................................................................................................................................... 3
Supported Test Types .................................................................................................................................... 3
Terminology ................................................................................................................................................... 4
Overview........................................................................................................................................................ 4
Application Panels ......................................................................................................................................... 5
Status Panels.................................................................................................................................................. 6
GETTING STARTED ............................................................................................................................................. 7
Performing a Rate Test (Plain Ethernet) ........................................................................................................ 7
Performing a Rate Test (IPv4 version) ........................................................................................................... 8
Performing an Errored Frames Filtering Test .............................................................................................. 10
APPLICATION REFERENCE ................................................................................................................................ 11
Physical Ports Panel ..................................................................................................................................... 11
Selected Ports Panel .................................................................................................................................... 11
General Test Configuration Panel................................................................................................................ 13
Test Types Configuration Panel ................................................................................................................... 16
Protocol Segment Profiles ........................................................................................................................... 26
Reporting Options Panel.............................................................................................................................. 29
Result Data Panel......................................................................................................................................... 30
Configuration Errors Panel .......................................................................................................................... 31
Application Settings ..................................................................................................................................... 31
COMMAND LINE INVOCATION ........................................................................................................................ 32
Invocation Details ........................................................................................................................................ 32
Command Line Options ............................................................................................................................... 32
TROUBLESHOOTING ........................................................................................................................................ 33
Basic Instructions ......................................................................................................................................... 33
Additional Details ........................................................................................................................................ 34

2

USER MANUAL

INSTALLATION
Windows
Valkyrie2889 is a standard Windows .NET application supporting Windows XP (SP3) and all later
Windows versions. It requires Microsoft .NET version 4.0.
After installation, you can find a shortcut to the application either in the Start -> Programs -> Xena
Networks menu or (if you have selected this during setup) on your desktop.
The application is installed as part of the Xena software release package which can be obtained
here.
Linux Support
Refer to this page for details on support for Linux.

GENERAL INFORMATION
CAPABILITIES
The Valkyrie2889 application features the following capabilities:
•
•
•
•
•
•
•
•
•
•
•
•

Enables the user to create, edit and execute test configurations using Xena Networks test
equipment in accordance with RFC 2889.
Ability to individually configure and enable the test-types defined in RFC 2889.
Support for multiple ValkyrieBay and ValkyrieCompact test chassis.
Support or different network topologies and traffic flow directions.
Support for both layer 2 and layer 3 testing.
Support for IPv4 and IPv6.
Support for all IGMP/MLD versions.
Support for multiple ValkyrieBay and ValkyrieCompact test chassis.
Ability to flexibly define the protocol layers supported by the test (Ethernet, VLANs, IP, UDP, etc.).
Ability to assign separate protocol layer definitions to each test port.
Test reports can be created in either PDF or XML format or both.
Extensive configuration options to fine-tune the tests.

SUPPORTED TEST TYPES
The following RFC 2889 test types are fully supported by the Valkyrie2889:
•
•
•

All Throughput and Forwarding rate tests (both Fully and Partially meshed)
Congestion Control
Forward Pressure and Maximum Forwarding Rate
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•
•
•

Address Caching Capacity
Address Learning Rate
Broadcast Frame Forwarding and Latency

The following RFC 2889 test types are partially supported by the Valkyrie2889:
•

Errored Frames Filtering: Supported with the exception of the "Dribble Bit Errors" and "Alignment
Errors" tests.

TERMINOLOGY
This section provides explanations for the terminology used by the Valkyrie2889.
Test Type
Denotes one of the test types defined in RFC 3918, sections 4 to 8, such as "Mixed Class Throughput" and
"Multicast Latency".
Trial
A "trial" denotes a single execution of a test with a given set of test parameters. If the test configuration
specifies that the tests shall be performed at various packet sizes a number of trials will then be executed one for each packet size specified.
Iteration
Each test type can be configured to repeat the test a number of times. Each of these repetitions is called an
iteration. One iteration may comprise several trials.

OVERVIEW
The main Valkyrie2889 application screen is shown in the image below.
•
•
•
•

At the top you find a menu bar with accesses various application-level functions. You also find a
toolbar with quick shortcuts to the most used functions.
At the left you find a tree view named "Physical Ports" showing the available Xena chassis, modules
and ports.
At the right you find a tabbed view with various application panels. These are explained below.
At the bottom you also find a tabbed view containing a few status panels. These are also explained
below.
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APPLICATION PANELS
Panel

Explanation

Start Page

The default main page shown to the user. This page contains a brief
guide to assist you in creating an initial test configuration. You can
close this panel once you feel that it is no longer useful to you.

Selected Ports

This panel allows you to include Xena testports in your test and to
configure the behavior of these ports. You select the ports in
the Physical Ports view and drag them to theSelected Ports panel to
include them in the test.

General Test

This panel control the common aspects of the Test Configuration, such
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Configuration

as frame sizes and port rates.

Test Types
Configuration

This panel control what tests you are actually going to execute and
also handles the testtype-specific configuration options.

Protocol
Segment Profiles

This panel allow you to create and/or configure profiles for protocol
segment headers. Each port can be assigned a different protocol
header so that it is possible to give each port a different set of

Reporting
Options

This panel control all aspects of the reporting function.

STATUS PANELS
Panel

Explanation

Result Data

This panel displays the test result data in a grid view. Both the progress
counters and the final test data is shown. Progress counters are shown
using an italics font whereas the final data is shown with a normal font.

Configuration
Errors

This panel displays any configuration errors detected in your
configuration when attempting to start a test.
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GETTING STARTED
This section will help you getting started using the Valkyrie2889 by showing a few simple examples on how
to create and to execute various tests.

PERFORMING A RATE TEST (PLAIN ETHERNET)
This example explains how to create and execute a simple rate test using two testports.
A "rate test" is a test that focus on the throughput and forwarding aspects of the DUT. All the tests defined
in RFC 2889 sections 5.1 to 5.4 are considered to be rate tests. These tests mainly differ in terms of the
used network topology and traffic direction but the basic test methodology is the same for all rate tests.
In this example we will use a Full Mesh topology with three testports, using plain Ethernet traffic.

Perform the following steps to create and execute this test:
1. Start the Valkyrie2889 application.
2. Click the Add Chassis button in the toolbar and enter the IP address and password of the Xena
tester you want to use. Keep the default value of 22606 for the port number unless you know that
your tester is configured with a different port number. Press OK. The Valkyrie2889 will now
connect to the chassis and display all available modules and ports in the Physical Ports panel to the
left.
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3. Locate three testports that you want to use in the Physical Ports panel and ensure that they are
connected to your DUT. Select each port in the treeview, right-click and select the Add Port to Test
Configuration menu option in the popup menu. You can select multiple ports by holding down the
<Ctrl> or the <Shift> button while clicking with the mouse.
4. Change to the Selected Ports panel. You should now see the three ports you selected previously.
Leave each port configuration at its default value.
5. Change to the General Test Configuration panel. If you know that your DUT has a throughput that
is lower than the physical port speed by several orders of magnitude you can lower the used test
port rate in the Overall Test Port Rate section at the top-right. Otherwise you may leave the
general settings at the default values.
6. Change to the Test Types Configuration panel. You will now see a treeview to the left containing all
defined tests. All tests are enabled by default so you should start with clicking the "Disable All
Tests" button at the bottom of the treeview (this is the button with an empty square image). You
can also disable all tests by clicking the checkbox to the left of each test.
7. Re-enable the Full Mesh rate test at the top and select the entry in the treeview. This is display the
test options for this test in the configuration panel to the right. Note the list at the bottom of the
configuration panel which show all the selected ports.
8. Press the Select All Ports button at the bottom of the configuration panel. This will include all the
selected ports in the current rate test1. Leave all other configuration options at their default values.
9. Select the Save ... menu item in the File menu (or press <Ctrl-S> in order to save your configuration.
Give the configuration a suitable filename.
10. Press the Start button in the top toolbar (or press <Ctrl-T>). The test will now start.
11. The Result Data panel at the bottom will display both progress information while the test is
ongoing and also the final test results. Progress data will be shown with an italics font whereas final
test results will be shown with a normal font.
12. Once the test completes a PDF report will be generated and shown using your default PDF viewer
application.
The overall result will contain one result for the throughput test and one result for the forwarding test.

PERFORMING A RATE TEST (IPV4 VERSION)
This example will show how to expand the above rate test using IPv4 test traffic. It expands on the previous
example so we will only describe the main differences in detail. For the sake of variety we will use a Pairs
topology instead of the Full Mesh topology used in the previous example.

1

It may seem superfluous to have to select the ports you have already selected for the test. But several of
the tests in RFC 2889 require a subset of the globally selected ports.
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1. Start the application, and connect to a chassis as before.
2. Select two testports that are connected to a DUT that support IPv4 traffic and add them to
the Selected Ports panel.
3. Change to the Selected Ports panel. For each port set the Protocol Segment Profile option to the
"Ethernet / IPv4" profile.
4. Select the IP Address cell for the first port. Enter the IP address you want to assign to this port.
Note that the Gateway Address cell is automatically initialized using an educated guess for what
the gateway address might be. Change the Prefix and/or the Gateway Address cells as needed.
5. Configure the IP address options for the other port in a similar way.
6. Change the General Test Configuration options as needed.
7. Change to the Test Types Configuration panel, and disable all existing tests.
8. Add a new rate test by clicking on the Add button located at the bottom of the test treeview to the
left.The new test will be enabled by default.
9. Set the topology to Pairs and the direction to Bidirectional.
10. Set both ports to be used. Set the first port role to East and the other port role to West. Pair the
two ports together using the Port Peer column.
11. Save the configuration and start the test.
The overall result will contain one result for the throughput test and one result for the forwarding test.
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PERFORMING AN ERRORED FRAMES FILTERING TEST
This example will show how to configure and run one of the other test types.

1. Start the application, and connect to a chassis as before.
2. Select two testports that are connected to a DUT and add them to the Selected Ports panel.
3. Change to the Test Types Configuration panel, and disable all existing tests, except the "Errored
Frames Filtering" test.
4. Select both ports to be used in the test. Set one port as the Source and the other as
the Destination.
5. Save the configuration and start the test.
The result will show the amount of frames transmitted and received in the various frame groups.
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APPLICATION REFERENCE
This section explains the options available in the various configuration panels.

PHYSICAL PORTS PANEL
This panel displays all available ports on the
currently connected Xena chassis. It is possible
to connect to multiple Xena chassis at the
same time.

It also allows you to perform the following
actions:
•
•
•
•

View the current sync (link) and traffic
state of the ports.
View the ownership of the ports, i.e.
are the ports reserved and by whom.
Request or relinquish ownership of
ports.
Determine which ports will be used in
the multicast tests.

You can reserve or relinquish ownership of a port by right-clicking on it and selecting the appropriate
action. Note that the Valkyrie3918 will automatically reserve ownership of used ports when a test is
started.

SELECTED PORTS PANEL
This panel displays the ports that have been actively selected for use in the test configuration. The ports are
shown in a grid view with the following columns:

Column

Port Name

Explanation

The name (ID and type) of the port.
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Port Speed

The physical port speed to use in the test. Normally this should be left at
the default AUTO value, but certain DUTs require that the port speed is
fixed to a specific rate.

IP Address

The IP address that you want to use for the port. All ports in the
configuration need an IP address.

Prefix

The decimal network prefix for the address.

Gateway
Address

The gateway address for the assigned IP address. Usually this will be the
address of the DUT port which the test port is connected to.

Protocol
Segment
Profile

The protocol segment profile to use for this port. Profiles can be created,
edited and deleted in the separate Protocol Segment Profilespanel.
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Additional Port Settings
Below the grid view is a section with less-frequently-used settings:
Property

Explanation

Inter-Frame Gap

Specifies the minimum gap between frames generated for a port,
expressed as a number of bytes.

Speed Reduction:

Specifies an optional speed reduction on the transmit side of the
port, expressed as a ppm value.

Enable PAUSE
Mode:

Controls whether the port responds to incoming PAUSE frames.

Enable Auto
Negotiation:

Controls whether auto-negotiation for the port is enabled or not.

Changing Settings on Multiple Ports
It is possible to change settings on multiple ports at the same time by selecting multiple ports in the grid
view and then changing settings in either the grid view or the detailed settings panel below the grid. The
only setting that does not allow this is the IP address field, as this must always be a unique value.

GENERAL TEST CONFIGURATION PANEL
This panel controls the test options that are common for all tests. The various sections in the panel are
described
below.
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Frame Sizes
This section allows you to specify the frame sizes to be used by the various tests. The available frame size
options are divided into two groups, the "Fixed Sizes Per Trial" and the "Varying Sizes Per Trial".
As the name indicates the "Fixed Sizes Per Trial" group uses a single frame size per trial. It is possible to
specify multiple frame sizes which will cause the test to be repeated for each frame size. The "Varying Sizes
Per Trial" group will use many frame sizes for each trial. This is controlled by the hardware. Note that when
calculating bitrates the average frame size will be used.
Also note that the Errored Frames Filtering test will not used the frame size setting as it uses its own
frame size setup as part of the test.

Overall Test Port Rate
This section allow you to specify the overall rate used by the tests. You can specify the rate using one of the
following methods:
•
•
•

A fraction (percentage) of the physical port speed
A frame-rate (Fps) value
A bit-rate (Bps) value at either layer 1 or layer 2.2

Below the controls you can see the resulting percentages or rates for all selected port types.
Note that the Address Caching Capacity and Address Learning Rate tests do not use the overall test port
rate as they utilize their own rate definition. The Congestion Control and Forward Pressure tests also do not
use the overall test port rate as these tests are always performed at port line speed.

Misc. Options
Option

Use MicroTPLD if
needed:

Explanation

The normal Xena test payload (TPLD) section takes up 20 bytes and is
used for various purposes, such as latency measurements, loss and
misordering monitoring, payload integrity, etc. Due to this test payload it
may be impossible to make room for protocol headers such as IPv4+UDP
for smaller framesizes (e.g. ~64 byte).
By enabling this option you permit Valkyrie2889 to use the smaller
“micro”-TPLD if needed by the current framesize. The consequence of
this will be that realtime monitoring of packet loss is no longer possible.

2

Bit-rate (layer 2) = bit-rate (layer 1) x framesize / ( framesize + inter-frame-gap )
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Note that Valkyrie2889 will only use the micro-TPLD for a testrun if the
current framesize requires it. If you for instance use the default IEEE
packet size distribution you may encounter that the micro-TPLD is only
used for 64 byte packets but not for the other packet sizes.

Determines how Valkyrie2889 allocates test payload identifier (TID)
values.
Configuration Scope: Allocates a unique TID value for each stream
created. This option ensures that only packets intended for a given port
is taken into account. The downside is that for large configurations you
may quickly run out of TID values due to hardware constraints.
TID
Alloc.Scope:

Rx Port Scope: Allocate TIDs so that all streams received on any given
port have a unique TID. TID values are reused between ports. This allow
for larger configurations but the test is no longer able to detect if packets
are mis-delivered by the DUT.
Source Port ID: Allocate TIDs so that all streams from a given port is set
equal to the port index in the configuration. This is a slight variation of
the previous method.

Latency
Mode:

Toggle Sync
State:

Specifies the way the latency value is calculated. Refer to the description
of P_LATENCYMODE in the Xena Scripting Manual for a description of
the various values.

If checked the sync state for all selected ports will be toggled off and on
at the start of each test trial. This is done to ensure that the DUTs MACtables are cleared at the start of each test.
Note that the Address Caching Capacity and Address Learning Rate tests
do not use this option as they use their own definition.

Sync State Off
Period:

The number of seconds to keep the port sync state off.
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TEST TYPES CONFIGURATION PANEL
This panel allow you to select which tests are executed and configure their parameters.

Selecting Tests for Execution
All available tests are shown in the treeview to the left. You can select if a test is executed by using the
checkbox to the left of the test name. You can also use the two small buttons in the toolbar at the lower
part of the treeview to quickly enable or disable all tests.

Configuring Test Options
To inspect and optionally change the test options for a test, select the test in the treeview. The associated
test options will then be displayed in the configuration panel to the right.
Each test contains a port role configuration control at the bottom of the associated configuration panel.
This control enables you to select which of the selected ports should actually be used in the test and also to
configure the role that each port should play in the test.

Handling Rate Tests
The RFC 2889 defines several types of rate tests, but these are typically not possible to execute using the
same test setup as the required cabling and equipment will typically differ quite substantially. Instead the
Valkyrie2889 allow you to create and define the number of rate tests relevant for the actual DUT.
Each rate test consist of two possible subtests:
•
•

The Throughput test, which attempts to measure the maximum zero-loss rate for the DUT. This
test is an iterative test and will provide exactly one test result.
The Forwarding test, which performs a rate sweep and measures the loss at each rate. This test
provides one test result for each tested rate in the rate sweep.

You can enable either both these subtests or just one of them.
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To create a new rate test press the Add button located at the bottom of the test treeview. You can
configure both the topology and the direction for the rate test, and also set the port roles for the test.
To delete a rate test select the test and press the Remove button located at the bottom of the test
treeview.

Test-specific Options
This section describes the options available for the various test types.

Common Test Options
This section describes the test options found in all or most tests.
Option

Explanation

Duration:

The duration of each test trial in seconds.

Iterations:

The number of times to repeat each test trial with the same set of
test parameters.

Rate Test Options

Option

Explanation

Common Test Options

Test Label:

A text label for this rate test. Use this to assign a short description
of the purpose of the test.

Traffic Setup
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The topology of the test traffic:
•

Mesh: All testports send traffic to all other testports. The Direction
option is ignored as Mesh traffic is always bidirectional.

•

Blocks: Each testport is placed in either the East or the West block.
Every port in the transmitting block sends traffic to every port in

Topology:

the other block. The Direction option determines if only one block
or both will be transmitting.
•

Pairs: Each testport is placed in either the East or the West block.
Then the ports are paired together two and two. Traffic is only
flowing between paired ports. The Direction option determines
which ports will be transmitting.

Direction:

Determines the direction of the test traffic.

Throughput Test Options

Enable
Throughput
Test:

If checked the Throughput test will be executed. This is an
iterative test that will find the largest throughput rate with zero
loss for the DUT.

Initial Rate:

The starting rate to use. This is specified as a percentage of the
overall port rate defined in the general test options panel.

Maximum
Rate:

The maximum rate to use. This is specified as a percentage of the
overall port rate.

Minimum
Rate:

The minimum rate to use. This is specified as a percentage of the
overall port rate. If the iteration reaches this value the test is
stopped and the result will be FAILed.

Resolution

The trial stops when the difference between the current and the
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Rate:

last successful trial is less than the Resolution.

Forwarding Test Options

Enable
Forwarding
Test

If checked the Forwarding test will be executed. This is a rate
sweep test that will measure the forwarding rate and the loss for
the DUT at various transmit rates.

Start Rate:

The starting rate percentage used in the test.

End Rate:

The ending rate percentage used in the test.

Step Rate:

The rate step increment.

Port Role Configuration

Used?

If checked the port will be used in this test.

Port Role

Used to place the port in either the “East” or the “West” block.
Only available when Topology is either “Blocks” and “Pairs”

Port Peer

Used to pair the port with another port. Only available when
Topology is “Pairs”.

Congestion Control Test Options
This test does not use specific test options apart from the common test options described above.
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Forward Pressure Test Options

Option

Explanation

Interframe Gap
Delta

The difference between the default Interframe Gap (IFG) value
of 20 bytes and the reduced value used on the source port.

Accept. Rx Util.
Delta:

The acceptable receive rate utilization delta, i.e. the value with
which the receive rate is allowed to exceed 100.0%.

Maximum Forwarding Rate Test Options

Option

Explanation

Rate Sweep Options

Start Rate:

The starting rate percentage used in the test.

End Rate:

The ending rate percentage used in the test.

Step Rate:

The rate step increment.
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Address Caching Capacity Test Options

Option

Explanation

MAC Address Settings

Initial Count:

The starting address count to use.

Maximum
Count:

The maximum address count to use.

Minimum
Count:

The minimum address count to use. If the trial reaches this
value the test is stopped and the result will be FAILed.

Resolution
Count:

The trial stops when the difference between the current and
the last successful trial is less than the Resolution.

Learning Rate Settings

Learning Rate:

The learning rate in frames/second to use.

DUT Address Learning Reset

Toggle Sync
States:

If checked the sync state of the test ports will be toggled off
and on between test trials. Enabling this may help clearing the
MAC learning tables in the DUT and speed up the test.

Sync State Off
Period:

The amount of seconds the port sync states will be off.
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Switch Test
Port Roles:

If checked the port with the Test and Learning roles will be
swapped between test trials. Enabling this may help clearing
the MAC learning tables in the DUT and speed up the test.

DUT Aging
Time:

If none of the two options above are checked the test will wait
for the specified seconds between trials to ensure that the
MAC table in the DUT has been cleared.

Misc. Options

Fast Run
Resolution:

Enable this option to perform fast resolution of a testrun
based on polled data – the testrun will stop when a packet is
received on monitoring port.

Address Learning Rate Test Options

Option

Explanation

MAC Address Settings

Learning
Base
Address:

The first 3 bytes of the MAC addresses used for the learning test. It
is necessary to use a different base address than the default Xena
base address (04.F4.BC) when running a test using multiple
addresses to avoid conflicts with other unused ports on the Xena
tester.

Start
Count:

The starting number of addresses used in the test.

End
Count:

The ending number of addresses used in the test.

Step
Count:

The address count step increment.
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Only Use
Max.
Capacity:

If checked the test will ignore the start, end and step options and
only run the test at the max. capacity.
This option is only used if an Address Caching Capacity test has
previously been run as part of the same test and a capacity test
result has been found for the frame size in question. Otherwise the
test will default to use the start, end and step options.

Set End =
Max.
Capacity

If checked the test will ignore the end count option value and use
the max. capacity value instead.
This option is only used if an Address Caching Capacity test has
previously been run as part of the same test and a capacity test
result has been found for the frame size in question. Otherwise the
test will default to use the end option value.

Learning Rate Settings
Base
Learning
Rate:

The basic (i.e. maximum) learning rate used in frames/second. Note
that the general port rate defined for the test configuration is
ignored for this test.

Initial
Rate:

The starting rate to use. This is specified as a percentage of the
base learning rate.

Maximum
Rate:

The maximum rate to use. This is specified as a percentage of the
base learning rate and will typically be 100%.

Minimum
Rate:

The minimum rate to use. This is specified as a percentage of the
base learning rate. If the trial reaches this value the test is stopped
and the result will be FAILed.

Resolution
Rate:

The trial stops when the difference between the current and the
last successful trial is less than the Resolution.

DUT Address Learning Reset
Refer to the description for the equivalent options in the Address Caching
Capacity test.
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Errored Frames Filtering Test Options
Option

Explanation

Rate Sweep Options

Start Rate:

The start rate to use in percent of the overall port rate
defined.

End Rate:

The end rate to use in percent of the overall port rate
defined.

Step Rate:

The step rate to use in percent of the overall port rate
defined.

Test Frame Options

Enable Oversize
Test:

If checked the oversize frames test will be performed. You
can disable this if your DUT generally supports very large
frame sizes and you don’t want to bother testing this.

Max. Valid Frame
Size:

The maximum valid frame size you believe your DUT should
support.

Oversize Test
Span:

The number of oversize frame sizes to use in the test. The
frame sizes used will be in the range [max. valid size + 1,
max. valid size + span].

Min. Valid Frame
Size:

The minimum valid frame size you believe your DUT should
support. This value should typically be 64.
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Undersize Test
Span:

The number of undersize frame sizes to use in the test. The
frame sizes used will be in the range [min. valid size – 1, min.
valid size – span].

Broadcast Forwarding Test Options
Option

Explanation

Throughput Test Options

Initial Rate:

The starting rate to use. This is specified as a percentage of
the overall port rate defined in the general test options
panel.

Maximum Rate:

The maximum rate to use. This is specified as a percentage
of the overall port rate.

Minimum Rate:

The minimum rate to use. This is specified as a percentage
of the overall port rate. If the iteration reaches this value
the test is stopped and the result will be FAILed.

Resolution Rate:

The trial stops when the difference between the current
and the last successful trial is less than the Resolution.

PROTOCOL SEGMENT PROFILES
This panel allow you to manage the protocol segment profiles used for the test ports. The Valkyrie2889
enables you to define an asymmetric traffic setup so that each port potentially can be configured using a
separate profile.
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Managing Profiles
You can create and delete profiles to match the need of the current test scenario. To create a new profile
press the Add Profile button. To delete a profile select it in the listview and press the Remove Profile
button.
You can however not delete a profile that is currently being used by a testport. You can see the number of
testports currently using a profile in the "Use Count" column in the listview at the top. To delete a profile
that is in use you will first have to reassign all ports currently using that profile to another profile.

Default Profiles
When you create a new Valkyrie2889 configuration it will be populated with a number of default profiles.
You can however freely modify and even delete one or more of the default profiles.
If for some reason, you want to restore the default profiles you can press the Restore Default Profiles
button. This will unconditionally remove all current profiles (also those that are in use) and restore the
default set. All test ports will be associated with the first default "Ethernet-only" profile.
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Configuring Profiles
You can edit each profile by selecting it in the top listview and using the treeview control below.

Add and Remove Segment Headers
To add a new segment header, press the Add button in the Segments section to the right. You will
then be presented with a dialog listing all built-in segment types from which you can select one or
more types to be included. If you want to use a segment not currently supported by the
Valkyrie2889 you can add a raw segment and specify the length in bytes. You can then afterwards
edit the values in the resulting segment using the hex editor at the bottom.
You can remove one or more segments by selecting them and pressing the Remove button in the
Segments section. You can change the order in which the segment headers appear by using the
Move Up/Down buttons.
The Valkyrie2889 will automatically adjust the value of any standard "next-protocol" field (such as
the EtherType field) in the segment headers when other segments are added, removed or moved.

Editing Field Values
The segment editor provides a treeview similar to the one found in the Wireshark protocol
analyzer. You can thus expand each segment branch to view and optionally modify the various field
values. Each field title is preceded with a small icon indicating the type of field value (decimal,
hexadecimal, binary or IPv4/IPv6 address).
Certain fields, such as the EtherType, are associated with a set of commonly used named values.
These can be selected in the Named Values column. You are however free to enter any value you
want in the Raw Value column.
You can also edit the hex value of the segment headers directly using the hex editor at the bottom
if you are so inclined.

MAC and IP Addresses
The address fields in the Ethernet and IP section headers will usually be overridden by the
Valkyrie2889 when the teststreams are created:
•
•

The Source MAC (SMAC) address field in the first Ethernet segment will be set to the MAC
address of the source port.
The Destination MAC (DMAC) address field in the first Ethernet segment will be set to the
MAC address of the destination port. If an IP segment has been defined and a gateway IP
address is defined for a source port, the Valkyrie2889 will however attempt to resolve the
MAC address of the gateway using ARP or NDP and wil then use this MAC address as the
DMAC.
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•

The IP Source/Destination Address fields in the IP segment header will be set to the values
configured on the ports, as explained in the Selected Ports panel section above.

This replacement will however only be performed if you leave the fields at their default (all-zeros)
value. If you specify anything else this value will be used instead.

PCAP Import
You can import the protocol segment structure from a PCAP file captured using Wireshark or any other
capture application capable of generating a standard PCAP file. If the file contains multiple packets
Valkyrie2889 will display a list allowing you to select the desired packet.
Valkyrie2889 will attempt to decode the packet and display the known protocol headers and their fields.
Any unknown fields will be displayed as a raw segment. As there are limitations in the max.size of a custom
segment the import may not be possible in some cases. The import dialog will inform you about this if the
situation arises.

REPORTING OPTIONS PANEL
The Reporting Options panel contains a number of options that affect the way reports are generated for
the test.

Identification
This section contains a number of options that can help identify the test context.
•
•
•

Customer Name: The name of the customer for which the test is performed.
Customer Service/Access Id: These two options allow you to provide details about the network
circuits you are testing.
Comments: Allows you to provide any multi-line comments for the test configuration.

Report Generation
This section contains options that affect the way reports are generated.
•
•
•
•
•

Report Filename Prefix: Specifies the prefix for the report filename.
Append Timestamp to Filename: If checked a timestamp on the form <YYYYMMDD-HHMMSS> is
appended to the filename prefix.
Include Detailed Port Information in Report: If checked the report will also contain detailed rsults
for each port. If unchecked only the totals will be reported.
Include Charts in Report: If checked the report will include bar charts showing the test results. This
is only applicable for PDF type reports.
Throughput Unit for Charts: Use this to select whether to use frames/second ot bits/second as the
unit for throughput charts.
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Report Formats
This section allows you to select which types of reports will be generated. You can enable several types. The
generated report files will be given a file extension that matches the selected type, i.e. ".pdf" for PDF files
and so forth.

XML Report Specification
You can find the specification for the XML Report here.
In the Report formats section you can also activate the "Also Log Intermediate Results" option. It will log
intermediate results for each test type to separate CSV logfiles (one for each enabled test type) located in
the "ResultLog" subdirectory in the main Xena2889 Reports directory.

RESULT DATA PANEL
The Result Data panel will display both polled progress data and result data for the tests being executed in
a grid view. Each result will be shown in a single line in the grid.
The polled progress data is updated periodically while the current test trial is executing and will be shown
with an italics font. After the test trial has completed the result data for that trial will be calculated and
shown with a normal font.
The Result State column will shown the state of the current trial run. While the test trial is in progress the
state will always be "(pending)". A trial result may be final in which case the column will show either
PASS or FAIL, depending on the test outcome. If the test needs to perform another iteration the state will
again be "(pending)".

The columns used will depend of the test being performed. Most tests will provide a set of "totals" values
and a set of per-port values but as stated this depends on the test.
Most cell values will be displayed using the normal font color. Values that indicate an error, such as a nonzero loss value, will be displayed with a red font color.
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CONFIGURATION ERRORS PANEL
This panel will show any configuration errors detected by the program when you attempt to execute a
configuration. If any such errors are found the panel will be shown and the execution attempt will be
aborted. You will have to correct any reported errors before the program will allow you to execute the
configuration.

Each error will be shown in a separate line in the panel. If you double-click on an error message you will be
taken to the relevant configuration panel that will allow you to correct the error.
This panel is by default found in the lower auto-hiding panel group. By "auto-hiding" we mean that the
panel is initially hidden but will popup either if the panel tab is clicked or if the Valkyrie2889 program
decides that it is necessary to direct the attention of the user to the panel. You can make the panel visible
always by clicking the little "pin" icon in the top-right of the panel header.

APPLICATION SETTINGS
The Valkyrie3918 application features a number of application-level settings which are valid for all test
configurations. These can be accessed in the Options menu item as shown in the figure below.
•
•

•
•

•
•

Set Username: Allows you to specify the username used when logging in to the Xena testers. The
default value will be your Windows username (shortened to 8 characters if longer).
Ask to Relinquish Ports: If checked the Valkyrie3918 will prompt you when you try to use a port
which is currently reserved by someone else. If unchecked the Valkyrie3918 will unceremoniously
relinquish the port and reserve it in your name.
Open Last Configuration On Start: If checked the configuration you had open when you last closed
the application will automatically be opened the next time you start the application.
Set Reports Path: Allows you to specify a different location for the generated reports. The default
location is <ProgramData>XenaNetworksValkyrie3918Reports. The location of<ProgramData>
varies between versions of Windows but can be obtained by inspecting the environment variable
"ProgramData".
Set Tester Company Name: Allows you to set the name of the company performing the tests. The
default value is "Xena Networks ApS"
Set Tester Company Logo File: Allows you to specify the path to an image file which will be used as
the logo in the reports. The default logo is the Xena Networks logo. The image can be in PNG or JPG
format. It should have the approximate dimensions of 150 x 60 pixels and be set to a DPI of 96.
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•

Open Report in Associated Viewer: If checked the Valkyrie3918 will attempt to open the generated
report in the associated viewer. This is currently only applicable for PDF reports. This requires that
a suitable PDF viewer (such as the Adobe Acrobat Reader) is installed on your PC.

COMMAND LINE INVOCATION
The Valkyrie2889 supports a number of command line options which can be used to automate the
execution of a predefined configuration file.

INVOCATION DETAILS
Valkyrie2889 is part of a new series of Xena test tools series that does not require a separate executable file
to perform the command line functionality. The same executable (Valkyrie2889_<version>.exe) is used for
both the GUI and the command line functions.

COMMAND LINE OPTIONS
The valid command line options are as follows:
Command option

Explanation

-c, –config

Load a test configuration file with the specified path.

-e, –execute

Execute the specified test configuration file (requires -c <file>). If this option is used
the program will not show the GUI but will run in command line mode.

-u, –user

Set the username used when logging on to Xena testers (default: xenarun).

-r, –reportpath

Set the path where reports are saved.

-o, –company

Set the company name used in reports.
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-l, –logo

Set the path to the report logo file.

-h, –help

Display this help screen.

TROUBLESHOOTING
This section contains some guidelines when you encounter a problem with one of the Xena test
applications, such as ValkyrieManager, Valkyrie2544, Valkyrie1564, Valkyrie3918 or Valkyrie2889 and
want to obtain help from your support representative.

BASIC INSTRUCTIONS
This section explains how you should report a problem to your support representative.

Describe the Problem
To enable fast resolution of your problem we request that your support request contains the following
information:
•

Name and version of the Xena test software used (the version can be seen in the main title bar)

•

A description of what you are trying to do with the software.

•

If the software misbehaved please describe what you actually encountered and you expected instead.

•

Screenshots of any error situation.

•

The test configuration file for the application (contained in the support archive).

•

Any debug log files for the application (contained in the support archive).

Create a Support Information Archive
The Xena test applications include a menu entry called Create Support Information Archive which will
create a compressed ZIP archive containing both the currently loaded configuration file and the content of
the Logs and Settings directories. This file can then be emailed to your support representative.
For the Valkyrie2889 and similar test applications this menu entry is located in the Help menu. For the
ValkyrieManager application it is located in the Tools ribbon menu.
Please note: For the Valkyrie2889 and similar test applications it is important that the configuration file
used when the problem was detected is loaded when the support archive is generated. Otherwise the
configuration file will not be part of the archive.

Attach Screenshots
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Screenshots are a great and easy way of communicating what you see on the screen. To obtain a
screenshot of a running program and send it to Xena support perform the following actions:
1. Point your mouse inside the program window.
2. Press the <Alt-PrintScr> keys simultaneously.
3. Switch to your email program and start a new email message.
4. Press <Ctrl-V> or select “Paste” from the menu (most likely the “Edit” menu) to insert the
screenshot into the email.

ADDITIONAL DETAILS
This section goes into a bit more detail about the various items contained in the Xena Support Archive
mentioned above.
Configuration Files
The Xena test applications keeps their configurations in special files with an application-specific
extension. The extensions used are as follows:
Valkyrie2544:

*.x44 or *.x2544

Valkyrie1564:

*.x1564

Valkyrie3918:

*.x3918

ValkyrieManager:

*.xmcfg

The configuration files will be located in a common Xena data directory on your PC. More
specifically they will be located in the following
path: C:<UserAppDataDir>Xena<XenaTestApplication>. The <UserAppDataDir> directory depends
on your Windows version:
Windows Vista,
7 and 8:

C:Users<username>AppDataRoaming

Windows XP:

C:Documents and
Settings<username>}Application Data

The <username> is the name of the currently logged-in user.
The Xena test applications include a menu entry called Explore Xena Data Directory in
the File menu that will open a Windows Explorer in the correct directory, regardless of the
Windows version.
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Debug Log Files
The Xena test applications logs certain events and errors to a series of debug log file located in the
Logs subdirectory under the above mentioned main application data directory. If you encounter
errors it may help the support if you include these files in your support request.
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